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Подключение к сетевому 
маршрутизатору
Проигрыватель можно подключить к сетевому маршрутизатору с 
помощью одного из методов, указанных на этой странице.
❙❙ Проводная сеть

✎✎ Примечания
●● Доступ к серверу обновления программного обеспечения Samsung по сети 
Интернет может быть запрещен. Это зависит от используемого маршрутизатора 
или политики поставщика услуг. Для получения дополнительных сведений 
обратитесь к поставщику услуг Интернета.

●● Пользователям DSL для подключения к сети необходимо использовать 
маршрутизатор.

●● Для использования функции AllShare компьютер должен быть подключен к сети, 
как показано на рисунке слева. Подключение к сети может быть проводным или 
беспроводным.

Услуги широкополосной 
связи

Широкополосный модем 
 (со встроенным маршрутизатором)

Широкополосный 
модем 

Маршрутизатор

или

Услуги широкополосной 
связи

❙❙ Беспроводная сеть

✎✎ Примечания
●● Дополнительная информация может быть получена в руководстве пользователя к 
проигрывателю.

+

Услуги широкополосной связи

Беспроводной маршрутизатор Если данная модель проигрывателя 
не оснащена встроенным адаптером 

WiFi, необходимо использовать адаптер 
беспроводной локальной сети Samsung.
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Настройка сетевого соединения. 
Первые шаги

1	 Нажмите кнопку [HOME] на пульте 
дистанционного управления.

※※ Если используется беспроводная сеть, 
убедитесь, что точка доступа, которую 
необходимо подключить к проигрывателю, 
включена. Точка доступа может быть 
беспроводным маршрутизатором, модемом 
и т.д. Если используется проводная сеть, подсоедините один кабель локальной сети к 
сетевому порту на задней панели проигрывателя, а другой – маршрутизатору или модему.

2	 На домашнем 
экране перейдите 
к параметру 
<Настройки>, затем 
нажмите кнопку s.

3	 Перейдите к 
параметру <Сеть>, 
затемнажмите кнопку 
s.

HOME SMART

HUB

4	 Перейдите 
к параметру 
<Настройки сети>, 
затем нажмите кнопку 
s.

5	 Когда отобразиться 
окно Настройки сети, 
перейдите к разделу 
“По настройке 
проводных сетей” на 
стр. 5 или к разделу 
“По настройке 
беспроводных 
сетей” на стр. 6 для 
завершения настроек 
сети.

※※ Проигрыватель поддерживает различные способы настройки сети (проводной/
беспроводной, WPS (PBC)), что позволяет настраивать сеть легко и быстро.
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❙❙ Для проводных сетей

Проводная – Авто

Используйте автоматическое подключение, если сеть не требует 
статического IP-адреса. Большинство сетей не требуют статический IP-
адрес.

1	 Выберите Пуск в 
меню Настройки 
сети, затем нажмите 
кнопку s. 

✎✎ <Пуск> обычно 
выделяется 
автоматически.

2	 После проверки 
сетевого соединения 
проигрыватель снова 
подключится к сети.  
Нажмите кнопку s,  
когда процесс 
сетевого соединения 
будет завершен.

Проводная – Ручная настройка

Если IP-адрес статический или функция автоматического подключения 
не работает, необходимо задать значения Настройки сети вручную. 

1	 Выберите <Пуск> на экране Настройки сети, затем нажмите 
кнопку s. Появится экран Состояние сети. Проигрыватель 
выполнил попытку подключения к сети, но произошел сбой. 

2	 В правой части 
экрана выберите 
<Настр-ки IP>, затем 
нажмите кнопку s. 
Отобразится экран 
Настройки IP.

3	 Выберите поле Режим IP, затем задайте для него значение 
Ручной.
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4	 Для ввода данных сети используйте номерные кнопки на пульте 
дистанционного управления. Для перемещения между полями 
для ввода данных используйте кнопки ▲▼◄► на пульте 
дистанционного управления.

✎✎ Эти данные можно получить у поставщика услуг Интернета. Эти данные также 
доступны на большинстве компьютеров с операционной системой Windows.

5	 По завершении 
выберите OK, затем 
нажмите кнопку s. 
После проверки 
сетевого соединения 
проигрыватель снова 
подключится к сети. 

❙❙ Для беспроводных сетей

1	 Убедитесь, что точка доступа, которую необходимо подключить 
к проигрывателю, включена. Точка доступа может быть 
беспроводным маршрутизатором, модемом и т.д.

2	 Выберите Пуск в 
меню Настройки 
сети, затем нажмите 
кнопку s.

✎✎ <Пуск> выделяется 
автоматически.

3	 Нажмите кнопку s.  
Проигрыватель 
начнет сканирование 
для точек доступа. По 
завершении поиска 
отображается список 
обнаруженных точек 
доступа.
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4	 Переместите 
точку доступа, к 
которой требуется 
подключить 
проигрыватель, 
а затем нажмите 
кнопку s. 
<Далее> выделяется 
автоматически.

5	 Нажмите кнопку 
s. Подключение 
проигрывателя к 
сети.

✎✎ Если сеть защищена, 
появится окно для ввода 
ключа безопасности сети. 
С помощью клавиатуры 
введите ключ. С помощью 
кнопок ▲▼◄► 
выберите Далее, 
нажмите кнопку s, а 
затем перейдите к шагу 6.

5-1	Если потребуется 
использовать 
фиксированный IP-
адрес, выберите на 
экране <Настр-ки 
IP>, а затем введите 
необходимые 
настройки IP-адреса 
вручную.
-- IP-адрес
-- Маска подсети
-- Шлюз
-- Сервер DNS

6	 После завершения 
настроек сетевых 
параметров нажмите 
кнопку <OK>.

✔✔ При использовании устройства, поддерживающее WPS 
1.	 Выполните действия с 1 по 5 в разделе "Настройка сетевого соединения. Первые 

шаги".

2.	 Выберите пункт “WPS(PBC)”.
3.	 Следуйте инструкциям, отображаемым на экране.

✎✎ Примечания
-- Устройства, поддерживающие WPS, имеют кнопку WPS (PBC).   
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Установка и использование 
программного обеспечения AllShare на 
компьютере

❙❙ Загрузка программного обеспечения AllShare

Для использования AllShare на компьютере или устройстве DLNA 
на компьютере необходимо установить программное обеспечение 
AllShare.  
Загрузить программное обеспечение AllShare и получить подробные 
инструкции по использованию AllShare можно с веб-сайта Samsung.
com. 

1	 Посетите веб-сайт www.samsung.com.

2	 Выберите пункт Поддержка в верхней части страницы. 

3	 На странице “Поддержка” введите номер модели проигрывателя 
в поле “Номер модели” и нажмите кнопку Найти продукт.

4	 На открывшейся странице щелкните элемент Получить загрузки 
в меню Загрузки. Отобразится страница центра загрузок. 

5	 На странице центра загрузок перейдите на вкладку 
программного обеспечения. 

6	 На вкладке программного обеспечения щелкните значок файла 
справа от строки AllShare.

7	 В появившемся всплывающем окне выберите Сохранить файл. 

8	 Найдите файл установки AllShare на диске, затем дважды 
щелкните файл. 

9	 В появившемся всплывающем окне щелкните Выполнить, затем 
следуйте инструкциям на экране.
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❙❙ Установка AllShare

Для установки программного обеспечения AllShare выполните 
следующие действия.

1	 После загрузки программного обеспечения AllShare запустите 
установщик.

2	 Выберите язык и 
нажмите кнопку 
“OK”.

3	 Проверьте место 
установки для 
программного 
обеспечения и 
лицензионного 
соглашения, если вы 
согласны, выберите “I 
accept the terms of the 
license agreement ”  
и нажмите кнопку 
“Next”.

4	 Файлы, которые 
требуются 
для запуска 
программного 
обеспечения, 
установлены.

5	 После того, как 
установка была 
завершена и были 
созданы ярлыки, 
выберите, следует 
ли запускать 
программное 
обеспечение, а затем 
щелкните “Finish”, 
чтобы завершить 
процесс установки.
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❙❙ Структура экрана AllShare

В программном обеспечении AllShare находится три экрана.
Экран управления файлами

Для перехода к экрану 
управления файлами 
необходимо выбрать в 
верхнем меню View > File 
management screen mode 
или нажать кнопку File 
management screen mode.

A.	 Область просмотра
●● Connected shared device : отображает общее содержимое на устройствах, 

которые подключены к компьютеру (определяется как Мой компьютер на 
экране).

●● Content list : отображает содержимое категорий видео/фотографий/музыки.
●● Transfer/Back up list : отображает процесс выполнения/завершения для 

передачи и резервного копирования.
●● Playlist : создайте и воспроизведите индивидуальный список композиций, 

фотографий и видео.

B.	 Область списка содержимого
●● Отображает содержимое списка, выбранного в области просмотра.

C.	 �Кнопки воспроизведения на другом устройстве/передачи на 
другое устройство/сохранения на мой компьютер

●● Play on another device : отображение выбора экрана для устройства, на 
котором будет воспроизводиться выбранное содержимое.

●● Transfer to another device : отображение выбора экрана для устройства, на 
которое будет передаваться выбранное содержимое.

●● Save to My Computer : отображение выбора экрана для папки, в которую 
необходимо сохранить выбранное содержимое.

D.	 Дополнительные функции
●● Refresh : обновление всего списка.
●● List view/Thumbnail view : щелкните, чтобы изменить метод списка.
●● Поиск : поиск содержимого в пределах области списка содержимого.

E.	 Player control screen mode
●● Выполняет переключение в режим экрана управления проигрывателем.
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2	 На вкладке Настройка привилегий для моего компьютера 
настройте привилегии общего доступа, с которыми каждое 
подключенное устройство имело бы папку общего доступа в 
разделе Мой компьютер.

●● При выборе параметра Всегда устройства могут использовать 
общее содержимое в разделе Мой компьютер. В первый раз 
устройства запросят доступ без всплывающего уведомления.

●● Allow all/Forbid all : Право/запрет на привилегированный 
доступ для всех текущих подключенных устройств.

●● Можно настроить привилегированный доступ для каждого 
устройства, выбрав параметр разр./блок., находящийся рядом 
с каждым подключенным устройством в списке.

●● Чтобы удалить устройство из списка, нажмите кнопку  рядом 
с устройством.

3	 В разделе Allow remote playback on Разр. удаленное 
воспроизведение на моем компьютере, установите правила 
удаленного воспроизведения для каждого устройства, которое 
имеет доступ к разделу Мой компьютер.

●● “Always show pop-up when playback is requested” : При выборе 
AllShare отобразит запросы на воспроизведение от других 
устройств в разделе Мой компьютер во всплывающем окне.

●● Always allow : когда другое устройство запрашивает 
воспроизведение в раздел Мой компьютер, воспроизведение 
предоставляется без всплывающего уведомления.

●● Never allow : устройства не могут выполнить воспроизведение 
в разделе Мой компьютер.

Подключение к проигрывателю и другим 
совместимым устройствам DLNA

Прежде чем выполнить подключение к устройству необходимо 
подключить компьютер к домашней сети.

✎✎ Примечания
-- Если возникла ошибка во время подключения к домашней сети, обратитесь к 

сетевому администратору или поставщику услуг Интернета/маршрутизатора.
-- Если возникла ошибка при подключении к устройству DLNA (например: 

мобильный телефон), обратитесь к руководству пользователя данного 
устройства.

❙❙ Доступ к подключенному устройству

1	 Перейдите на 
вкладку Tools > 
Settings > Privilege 
settings.
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Добавление папок общего доступа
Можно добавить папку общего доступа одним из следующих вариантов.

●● На экране управления файлами в верхнем списке устройства в левой части 
экрана нажмите кнопку Папка общего доступа, выберите папку для общего 
доступа в отображающемся списке, затем нажмите кнопку OK.

●● Нажмите кнопку File > Add shared folder from My Computer, выберите папку 
для общего доступа в отображающемся списке, затем нажмите кнопку OK.

●● Нажмите Tools > Settings > Folder Settings > Add Shared Folder. Выберите 
папку в отображающемся списке, затем нажмите в списке кнопку OK и снова 
откройте вкладку Настройка папки.

Добавление файла в папку общего доступа раздела Мой компьютер

Можно добавить файл в папку общего доступа одним из следующих 
вариантов.

●● На экране управления файлами в правой части экрана My Computer's Shared 
Folder нажмите Add files to play to the list. В отобразившемся окне файла 
выберите файлы общего доступа, затем нажмите кнопку Open. В отобразившемся 
окне нажмите Копировать, Переместить или Отмена. Если вы нажали Копировать 
или Переместить, файлы отобразятся на экране управления файлами.

●● Нажмите File > Add File to My Computer's Shared Folder. В отобразившемся 
окне файла выберите файлы общего доступа, затем нажмите кнопку Open. В 
отобразившемся окне нажмите Копировать, Переместить или Отмена. Если вы 
нажали Копировать или Переместить, файлы отобразятся на экране управления 
файлами.

Добавить из Проводник Windows

В Windows Проводник Windows выберите папку/файл общего доступа 
и перетащите в папку общего доступа раздела Мой компьютер/Область 
списка содержимого на экране управления файлами для добавления 
папки/файла общего доступа.

Создание списка воспроизведения в 
AllShare

●● Добавить список 
воспроизведения : нажмите 
Add new playlist рядом со 
списком воспроизведения 
и введите имя списка 
воспроизведения.

●● Play on another device : 
щелкните правой кнопкой 
мыши необходимый 
список воспроизведения и 
удерживайте курсор мыши  
на параметре Play on another device, чтобы выбрать устройство, на котором 
данный список необходимо воспроизвести.

●● Переименование списка 
воспроизведения: правой 
кнопкой мыши нажмите на 
список воспроизведения, 
который необходимо переименовать, затем нажмите Rename.

●● Удаление списка воспроизведения : правой кнопкой мыши нажмите на список 
воспроизведения, который необходимо удалить, затем нажмите Delete.

●● Добавление содержимого в список воспроизведения : Чтобы добавить 
содержимое в список воспроизведения, выберите список с содержимым, 
которое необходимо добавить в список воспроизведения Device List/Content 
List области навигации, выберите содержимое из области списка содержимого и 
перетащите его в список воспроизведения.

●● Удаление содержимого из списка воспроизведения : выберите список 
воспроизведения, из которого необходимо удалить содержимое. Выберите 
содержимое для удаления, затем щелкните правой кнопкой мыши содержимое и 
нажмите Delete или нажмите клавишу Delete для удаления содержимого. 
(Удаление содержимого из списка воспроизведения не приводит к его удалению 
в списках Список устройств или Список содержимого.)
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Выбор устройства на экране AllShare 
Play проигрывателя

1	 Подключите необходимые устройства к проводной/беспроводной 
сети.

2	 Выберите AllShare Play на домашнем экране проигрывателя дисков 
Blu-ray, затем выберите содержимое для воспроизведения (видео, 
фотографии или музыку).

3	 В правой части экрана 
выберите устройство 
с содержимым, 
которое необходимо 
воспроизвести.

✎✎ Примечания
-- Даже если программа AllShare не установлена, устройства DLNA можно 

подключать и они могут отображаться на экране проигрывателя AllShare Play. 
(Они должны быть сначала подключены к сети.)

-- Устройства несовместимые с устройствами Samsung не удастся подключить.

Воспроизведение проигрывателя 
дисков Blu-ray с другими устройствами

❙❙ �Смартфон подключается к компьютеру для 
воспроизведения файла через проигрыватель 
дисков Blu-ray 

Используйте смартфон для просмотра файлов, хранящихся на 
компьютере, для воспроизведения выбранного файла через 
проигрыватель Blu-ray на телевизоре. 
(Доступно только для телефонов Samsung, поддерживающих функцию 
AllShare.)

1	 Подключите компьютер, смартфон и проигрыватель дисков Blu-ray к 
проводной/беспроводной сети.

2	 Запустите программу AllShare на своем компьютере.

Компьютер

Подключение AllShare
Управление файлом компьютера  
на проигрывателе дисков Blu-ray

Смартфон

Проигрыватель дисков Blu-ray

Воспроизведение 
файла компьютера
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3	 Запустите программу AllShare на своем телефоне и подключите его к 
компьютеру. (Внимание! Необходимо имя компьютера.) 

4	 На компьютере проверьте, подключен ли телефон.

5	 После подключения можно просмотреть файлы общего доступа с 
компьютера по телефону.

6	 Выберите необходимый файл из общего списка и затем выберите 
устройство для воспроизведения (проигрыватель дисков Blu-ray). 

7	 Подтвердите, что в качестве воспроизведения файла выбран 
проигрыватель дисков Blu-ray.

❙❙ �Воспроизведение видеофайлов с компьютера на 
проигрывателе

Вы бы хотели смотреть фильм через проигрыватель с семьей по 
телевизору или в одиночестве на компьютере? 
Воспользуйтесь программой AllShare для перемещения содержимого на 
проигрыватель. 
Добавьте содержимое или папку общего доступа для воспроизведения.

1	 Включите проигрыватель.

2	 Запустите программное обеспечение AllShare на компьютере.

Компьютер

Подключение AllShare

Проигрыватель дисков Blu-ray

Воспроизведение 
файла компьютера
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3	 Если папка, 
содержащая 
видео для 
воспроизведения, 
не является общей, 
нажмите кнопку 
рядом с “My 
computer’s shared 
folder” для ее 
добавления.

✎✎ Если в памяти хранится 
большое количество 
файлов, для повторного 
создания списка может 
потребоваться некоторое 
время.

￼￼￼￼

4	 В списке 
содержимого 
выберите видео, 
которое необходимо 
воспроизвести.

5	 Нажмите кнопку 
“Play on another 
device”.

￼

6	 Выберите устройство, 
на котором будет 
воспроизводиться 
содержимое 
(проигрыватель 
дисков Blu-ray).

￼

7	 После того, как буферизация 
видео будет завершена, 
видео воспроизведется с 
помощью проигрывателя 
и появится на экране 
телевизора.

✎✎ Убедитесь в том, что 
телевизор настроен в 
соответствии с источником, 
к которому подключен 
проигрыватель Blu-ray.
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❙❙ �Воспроизведение видеофайлов со смартфона на 
проигрывателе

1	 Подключите смартфон и проигрыватель дисков Blu-ray к проводной/
беспроводной сети.

2	 Выберите AllShare Play в главном меню проигрывателя дисков 
Blu-ray. 

3	 Запустите приложение AllShare на смартфоне. Выберите в 
программе AllShare меню Воспроизведение файла с телефона 
на другом проигрывателе.

4	 Выберите содержимое (видео, фотографии или музыку) для 
воспроизведения. Выберите устройство, на котором требуется 
воспроизвести медиа-клип.

5	 После подключения 
можно просмотреть 
всплывающее 
сообщение на 
проигрывателе 
дисков Blu-ray.

6	 Выберите Разр. во всплывающем сообщении, затем нажмите 
кнопку s.

✎✎ Примечания
-- <Разр.> выделяется автоматически.
-- Данная функция не поддерживается, если программа AllShare не установлена 

на смартфоне.

Смартфон

Подключение AllShare

Проигрыватель дисков Blu-ray

Воспроизведение 
файла смартфона
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Вопросы и ответы
Я только что установил программу AllShare на компьютер, но не 
могу найти свой компьютер в приложении программы AllShare на 
проигрывателе.

●● Убедитесь, что проигрыватель и компьютер подключены и соединения 
зафиксированы.

●● Убедитесь, что все соединения сетевого кабеля (маршрутизатор к компьютеру, 
маршрутизатор к модему и т. д.) подключены и зафиксированы.

●● Убедитесь, что проигрыватель подключен к вашей сети и сетевая конфигурация 
проигрывателя верна.

●● Убедитесь, что для проигрывателя и компьютера назначены верные IP-адреса.
●● Убедитесь, что проигрыватель и компьютер подключены к одному сегменту сети. 
Сравните первые три цифры IP-адресов. Они должны совпадать.

●● Убедитесь в том, что для проигрывателя установлено значение Разрешено на 
вкладке Настройка привилегий программы Allshare на компьютере. (Tools > 
Settings > Privilege settings).

●● Некоторые приложения брандмауэра, запускаемые на компьютере, такие как 
McAfee и Norton AntiVirus могут блокировать операции программы AllShare 
и доступ проигрывателя к компьютеру. Отключите такие программы или 
установите для них значение Разрешено, чтобы приложения AllShare получили 
доступ к компьютеру.

Я не могу найти IP-адрес проигрывателя дисков Blu-ray в меню настроек 
прав программного обеспечения AllShare для компьютера.

●● Убедитесь, что проигрыватель подключен к вашей сети и сетевая конфигурация 
проигрывателя верна.

●● Убедитесь, что для проигрывателя и компьютера назначены верные IP-адреса.
●● Убедитесь, что проигрыватель и компьютер подключены к одному сегменту сети. 
Сравните первые три цифры IP-адресов. Они должны совпадать.

●● Убедитесь, что проигрыватель и компьютер подключены к одному маршрутизатору.
●● Проигрыватель может быть не распознан из-за некоторых моделей 
маршрутизатора или его настроек. Проверьте, поддерживает ли маршрутизатор 
многоадресную рассылку. Если поддерживает, проверьте многоадресную 
настройку маршрутизатора.

Я не могу найти содержимое мультимедиа, даже когда для файла задано 
значение Открыть общий доступ на компьютере.

●● AllShare не поддерживает все форматы файлов для общего доступа. Файлы 
в форматах, которые не поддерживаются AllShare, не будут отображаться на 
экране компьютера, даже если к ним открыт общий доступ.

●● Вы не сможете просматривать файлы кроме фильмов, фотографий и музыки.

Субтитры появляются, когда я воспроизвожу видео с устройства USB. 
Но они не отображаются, когда я воспроизвожу видео с помощью 
программы AllShare и подключения к компьютеру.

●● Убедитесь, что файл субтитров имеет то же имя, что и видеофайл (например: 
Edge_City.mp4 и Edge City.srt ) и оба этих файла находятся в одной папке.

●● Обратите внимание, что данная функция поддерживается только продуктами 
Samsung, совместимыми с программой AllShare. Данная функция не 
поддерживается, если смартфон не является продуктом компании Samsung. 


